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This document describes the EDGE CAD editor, the context and the concepts
behind its conception, as well as its use.

Introduction
EDGE — for ExtendeD Gdml Editor — is an easy-to-use GDML-based CAD editor. It provides a
powerful and flexible CSG model fully compliant with the GDML format, used by numerous
particle-matter interactions analysis tools based on the Geant4 library. EDGE provides also various
import/export capabilities from/to B-Rep based CAD formats.

EDGE has been developed by Artenum in the frame of its internal R&D activities and is available
through several of its commercial services offers, like SpaceSuite.

About GDML
Based on XML syntax, the Geometry Definition Markup Language (GDML) is the reference language
used to describe geometrical models (i.e. CAD models) for radiation modelling tools like Geant4,
ESA/GRAS or SPIS-IC. GDML is based on a rich CSG approach and can be used to create complex and
realistic geometrical systems to be used for various purposes.

As an XML-based language, it can be fairly well read by humans and it is quite simple to parse it.
However, one of its limits is that it is difficult to visualise what a GDML file is going to produce just
by looking at it in a tailored sense, i.e. as a 3D geometrical system. Although some viewers or editors
exist, only a few of them are publicly available, and they are not user-friendly or incomplete.
Moreover, most GDML editors so far cannot handle the depth hierarchy used in GDML.

Therefore, Artenum decided to develop a GDML editor based on the Keridwen IME. Its aim is to
propose a simple-to-use, cross-platform editor with good capacities of visualization.

Main functionalities
EDGE can either create or load a complete GDML model. In both cases, the user can modify the
properties of all the shapes or add new shapes. Moreover, shapes also have position and
orientation properties that allow placing them correctly. To facilitate the work for the user, position
and orientation can be applied to several objects at the same time. EDGE handles complex
hierarchies with several levels of depth.

EDGE also allows editing and attributing material properties to each shape individually. At any
time, the user can see the results of his work thanks to the real-time 3D.

After editing his file, the user can save the result back to GDML but he can also export it to the B-
Rep .geo format (the file format of Gmsh).

Supported formats
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Import

EDGE support natively the GDML format in reading and writing, but is also able to import
numerous B-Rep CAD formats like Gmsh’s geo or STEP-AP 203/214 and tessellated solids in STL or
UNV files. These import/export capabilities open interoperability bridges with other CAD tools and
multi-physics simulation software.

[import STEP-AP] | ../_images/import_step_ap.png

Figure 1. Example of imported STEP-AP model inside EDGE

Export and CSG-to-B-Rep decomposition

EDGE is able to convert GDML models into an equivalent Gmsh’s geo file, fully compliant with
tailored applications like SPIS. This conversion is not done by tessellation but by a proper CSG to B-
Rep decomposition with the view in Gmsh (on the left) of a model initially defined in EDGE (on the
right).

[Robbie in GDML] | ../_images/robbie_gdml.png

Figure 2. GDML model defined in EDGE

[Robbie in GEO] | ../_images/robbie_geo.png

Figure 3. B-Rep decomposition visualized in Gmsh

Caution and limit of warranties
The present document is intended to be a simple User Manual (UM) to help the user to use EDGE in
basic mode to create CAD modelling. This document does not attempt to provide to the future EDGE
user the whole expertise and knowledge needed to create a correct CAD modelling. The final
confidence in the relevance and accuracy of the CAD model depends on the user expertise and
remains his responsibility.

FOR THIS REASON, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY
APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING, THE COPYRIGHT HOLDERS
AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE
QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.


For an improved handling of the key concept addressed by EDGE or for any
further information, please contact the SpaceSuite team.
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Quick Start
The application as well as the present User Manual can be downloaded from the SpaceSuite Web
page.


Currently, EDGE can be used on most 64bits Linux platforms and Microsoft
Windows 10-11 64bits.

Starting Edge
Once downloaded, the zip file containing the EDGE snapshot has to be extracted on the machine
where it will be used on to ensure that the software is executable.


On Windows systems, the native unzipping method may encounter issues when
unzipping EDGE. You may want to use third-party application to avoid issues. The
unzipping has been successfully tested with the 7Zip / NanaZip applications.

Linux

Double-clicking on the bin/Edge file launches the application.

To start the application, it is also possible to open a terminal and just execute bin/Edge in the
application directory. It is then possible to indicate launching options, see the Command-line
launching options paragraph below.

Windows

Double-clinking on the Edge.exe will launch the application.

To use more advanced launching options, you can open a command invite, go the EDGE folder and
type Edge.exe. Options can be provided, see the Command-line launching options paragraph below.

Command-line launching options

It is possible to use options to launch EDGE. The options can be added (up to one at a time) after the
launching command. To know all the available options, the option –h can be used (such as Edge -h
or Edge.exe -h).

• -f path/to/gdml/file.gdml: this option enables loading the given file directly in the application
at start-up.
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Main Window
The graphical user interface of EDGE is intuitive and based on the concept of perspectives, where
the modelled system can be viewed and handled from different approach or points of view, like the
edition of the geometrical model, the definition of material properties or the assignment of these
materials to their correct geometric shape.

The top window elements of the graphical interface are common for all perspectives:

• Main Menu (at the top) corresponds to main control menu of the application.

• General Toolbar (just below) presents shortcut buttons to access preferences and open/save a
file (on the left) and also allows switching from a perspective to another (on the right). This
toolbar also grants access to the preferences panel.

Main elements of EDGE window (here in the geometry perspective)

The various perspectives are presented in details in next sections:

• Geometry edition

• Material definition

• Material assignment

• GDML File

Main menu
The main menu at the top of the application enables to access various general elements.

File menu

The File menu allows opening and saving GDML files and also various import and export options.
An option also permits opening recent files. Finally the exit option enables leaving the application.

Please note that EDGE can only load one file at a time. When opening a GDML file, if there are
unsaved modifications, the application will propose to save this work before replacing it by the new
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opened file.

In its trial version, EDGE does not allow exporting or saving to GDML.



EDGE tries to load all files, even if there are inconsistencies.

For example, if a file contains two solids with the same name, EDGE will only
consider the last element with this name and inform about this issue and the
chosen resolution.

Tools menu

The Tools menu offers various tools and shortcuts. From here, you can access the preferences panel
presented in preferences. The console log is displaying various messages from the application such
as errors and warnings.

With this menu, it is also possible to apply corrective patch to EDGE or install new feature plugin.
To do so, click on the correct item and a file choose will appear and asks where the patch/plugin is
located. Once installed, it is recommended to restart the application.

This menu also offers access to various tools and model computation operations which are
described in more details in model operations.

Other menus

The Views menu allows switching from one of the perspectives to another.

The Help menu is useful to access this user manual directly from within the application. This menu
also offers the about screen, resuming information about the software and installed
plugins/patches.

Preferences
The Preferences dialog box allows the setting of the applications options.

At the first launch of the application, the Preferences dialog box is shown and enables the user to
change the default parameters right away.
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Otherwise, it is available:

• In menu Tools › Preferences

•
With the  button on the General toolbar


For each option, a [ Reset to default ] button allows switching back to the initial
value.

3D viewer preferences

The first tab display options about the 3D viewer of the application:

Figure 4. 3D viewer preferences panel

Default world opacity

Sets the default opacity used when creating the world shape. Indeed, a colour is automatically
chosen for every new shape and this setting will choose the opacity for this colour. The value 0.0
is fully transparent while the value 1.0 is fully opaque. Please note that this setting will not
change the opacity of the world already displayed in the 3D view.

Default shape opacity

Sets the default opacity used when adding a new shape that is not the World shape to the 3D
view. For more details, see the previous preference about the world shape.

Display sizes in the 3D view

This option activates an additional widget when selecting elements in the 3D view: the size (in
meters) are directly shown. It is disabled by default for better clarity in the 3D view.

Show selected shape(s) above others

If this option is active (true by default) the selected shape(s) will appear above the others in the
3D view enabling to easily locate them. It may cause issues on some specific system with
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unstable 3D rendering and should be disabled in this case to avoid any issue.

Show tessellated edges

This option activates the highlight of the edges of tessellated shapes inside the 3D view.

GDML default material preferences

Figure 5. GDML material preferences panel

The second tab — shown above — offers options concerning the default GDML materials used in the
application. Indeed, when a new shape is created in EDGE, a default material is assigned to it that
can be changed later on in the Material Assignment perspective. Here, it is possible to select which
material will be assigned to the world element and to other elements. The selection can be
performed from within the Geant4 default materials list.

GDML writer preferences

The third tab — shown below — sets parameters for the GDML writer.
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Figure 6. GDML writer preferences panel

Save chosen colours to GDML file

If this option is selected, the colours chosen in the Geometry panel will be saved to the GDML file
using the <auxiliary> tag, and then when loading the file the colours will be the same. Be careful,
the content of the <auxiliary> tag is not interpreted by the Geant4 numerical kernel. This tag is
usually properly treated by the client code as explained in the GDML user manual.

Save current shape visibility to GDML file

If this option is selected, the <auxiliary> tag will be used in the GDML file to save whether each
shape is visible in the 3D viewer. Be careful, the content of the <auxiliary> tag is not interpreted
by the Geant4 numerical kernel, this visibility feature is only for visualisation purpose in EDGE.

Validation mechanism in GDML file

Choose the reference to the GDML file validator (.xsd) defined in the GDML file.

online

The validation process requires an internet connection when the file is loaded in other tools.

local

The validation is made locally with a validator file embedded on the local computer. The
saved GDML file can only be used on this computer as long as the EDGE application is not
moved.

none

No reference to a GDML file validator is written, then no validation will be processed when
the GDML file will be used by other tools.

Write default units

If this option is selected, the units will always be specified inside the GDML file even if they
equal to the GDML default units (milimeters for lengths and radians for angles);
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Write default values

If this option is selected, the values for optional fields will be written even if they equal to the
default value — it is the case for example for the position and orientation (0 is the default value);

Write non-used user-defined materials

If this option is selected and that the user has defined materials which are not assigned to a
geometric shape, those materials will be stored in the GDML file anyway;

General preferences

The fourth tab offers more general usability preferences, as shown below.

Figure 7. General preferences panel

Maximum number of recent files

this option controls the number of recent files stored by EDGE and accessible in the File › Open
recent… menu.

Enable drag’n’drop

Enables the possibility to move the elements in the Shapes tree using drag and drop gesture with
the mouse. It facilitates the modification of the hierarchy. To avoid unwanted modifications, this
option is disabled by default.

Distance unit for new shapes

this setting enables to define the default distance unit when adding a new shape (for distance
values and the position). It avoids to change the unit each time you create a new shape.

Angle unit for new shapes

same effect as the previous one but applies to angle units (for angles values and orientation).
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System preferences

The last tab sets preferences for the system, as shown below.

Figure 8. System preferences panel

Application cache directory

By clicking on the “Browse” button, the user can choose the path where the application stores its
temporary files. It may be useful to change this setting if you do not have write access to your
temporary folder (by default EDGE uses the operating system default temporary folder).

Maximum allocated memory

The user can choose the value (in Gb) of the available memory for EDGE. It can be useful to
increase this value when loading big files, without exceeding the system maximum capabilities.
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Perspectives

Geometry edition
The Geometry perspective is the main perspective of EDGE since it allows the creation and the
edition of geometrical elements.

Geometry perspective

It is the main perspective of EDGE displayed by default at the launching. It has three main panels to
edit the geometry, as shown below.

• Top left: Shapes Tree panel, to visualise and edit the list of geometric shapes;

• Bottom left: Properties panel, to edit the properties of the currently selected shape;

• Right: 3D Viewer panel provides a 3D view of the modelled system.

These panels, as well as the 3D View panel, can be moved, detached or maximised at the user’s
liking using the buttons on their top right corner.

Figure 9. Default arrangement of the geometry perspective

Shapes tree

The Shapes tree lists all the shapes currently defined in the geometrical model and displayed in the
3D scene.
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Figure 10. Shapes tree panel

It also shows the hierarchy of the shapes. The shape(s) currently selected is (are) highlighted in the
3D view on the right with a red box, and displayed "above" the others or not, depending on the
"Show selected shape(s) above others" preference.

It is also possible to move one geometry element and all its children elements to another logical
location in the geometry tree. This feature is available only when the "enable drag’n’drop"
preference has been enabled in the preferences.

On the left of each shape’s name, a click on the coloured box opens a dialogue that allows changing
the colour of the shape in the 3D view. It is also possible to change the transparency of the selected
element in this dialogue box, as shown below.

[Colour chooser dialog] | ../_images/colour_chooser.png

Figure 11. Colour chooser dialogue

Additionally, a checkbox on the right of the shape name controls the visibility of the object in the 3D
view. When changing the visibility on an assembly with this checkbox, all its children shapes
visibility is changed accordingly.

On the top of the tree, controls help in various ways to locate and select visibility of elements.

Button Action

Searches the tree for the shape with a name containing the text entered in the search
field next to it. Once a search has been made, the tree will be filtered on the found
elements, click again on the search button to clear the search and display the whole tree
again.

Expands/collapse the whole tree to see more or less shapes.

Enables to change the visibility of all shapes in the tree: if most shapes are visible, it will
hide all shapes, otherwise it will display all shapes.

On the bottom of the tree, buttons are used to control the shapes. Availability of buttons depends on
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the current selection of elements.

Button Action Available

Opens a dialogue box to add a new shape to the tree, if one
shape is selected, the new created shape will be added as
children of the selected shape. If none selected, the new
element will be set at the world element if the geometry is
empty or as children of the existing world element if
present.

Zero or one shape selected

Creates Boolean operation using selected shapes At least 2 shape selected

Duplicates the selected shape(s) At least 1 shape selected

Deletes all the shapes currently selected in the tree At least 1 shape selected

Offers the possibility to use a clipping filter Exactly 1 shape selected

Clipping tool

The clipping button triggers the apparition of a dialogue box allowing the user to set the
parameters of the clipping filter, as shown below. It performs a visual cut in the geometry to view
more precisely the inner geometry of the modelled system.

The clipping is set with the coordinates of a centre point and a normal direction.It will keep the
geometric representation of the selected element in the half-space defined by this point and the
normal.

To get a more interactive setting, you can select the [ Display 3D control widget ] option that will
display an interactive control in the 3D view to change the clipping. These 3D controls of the filter
are materialised by a sphere (representing the centre of the clipping operation) and an axis with
two arrows (representing the normal direction).

Figure 12. Clipping settings panel (right) and result inside 3D view (left)


The clipping filter is just a visualisation tool, it will not change the geometry
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definition.

Properties panel

This panel shows the properties of the shape currently selected in the Shapes tree. It shows shape
intrinsic properties only if there is one — and only one — shape selected. Depending on the shape
selected, the properties displayed change accordingly (not the same parameters for a box and a
sphere, for example). If several shapes are selected simultaneously, the properties panel will only
display position / orientation setup.

Shape properties

The user can thus define the dimensions of the shape. For each shape, parameters vary and
explanatory schemes are presented in the Supported shapes schematics annex. These pictures are
also available in the software by clicking on the  button.

Note on the Thickness parameter and Boolean operations

Some elements — such as boxes, ellipsoids, orbs, parallelepipeds and trapezoids — have an
additional useful parameter inside EDGE (not present in GDML) called thickness. If a shape
has a thickness defined (different from 0), then the export of this shape will be done using
Boolean operations (a subtraction between the outer element and the inner element). It
allows the user to gain time for this kind of operation.

This kind of shape can be very useful during the definition of radiation analysis. The user
shall be aware that this thickness value is not a GDML parameter, which means that setting
this parameter to a value different from zero will result, in the GDML file, to the
corresponding Boolean operation. The little warning sign next to the name of this parameter
is present to remind the user of this.

If an EDGE file containing a shape with a defined thickness (different from 0) has been saved
and is then loaded again, EDGE will try to reload it correctly as the initial shape with
thickness and not as the Boolean operation saved in the file.

Units selection

This panel shows also fields to choose the position and orientation of the object and the unit of
measure. The unit for parameters, positions and rotations can be changed and an automatic
conversion of values is proposed. The default units are millimetres (mm) for lengths and radians
(rad) for angles, but it can be changed in the preferences.

Position and orientation

The orientation parameter represents the orientation of the shape around its centre of mass: each
angle (also known as Euler angle) represents an orientation around the X, Y and Z axis respectively.


Those rotations are applied in the following order: first the Z orientation, then the
Y one and finally the X rotation. Then, and only then, the translation is applied.
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Setting position and orientation for several shapes

When several shapes are selected inside the tree, the properties panel will enable to change the
position and orientation of all the shapes with the panel below.

Figure 13. Multi shapes transformation panel

This panel allows setting the translation and rotation to apply to the elements. These
transformations can replace the current position and orientation properties of the objects or be
added to any existing placement information.

For example, for an object at a (1, 1, 1) position, a transformation of (2, 0, 0) with [ Add ]
selected will move the object to (3, 1, 1), when selecting [ Replace ] will move it to (2, 0, 0).

3D Viewer

The 3D Viewer is showing in real-time the product of the GDML model.

15



Figure 14. 3D viewer

It is possible to interact with the view using the mouse to control it:

Action

Left click (hold) and movement: rotate the scene

Wheel (hold) and movement: translate the scene

Right click (hold) and movement: zoom

Or, with the keyboard:

Key Action

R Resets the view and shows all the shapes of the scene

I to zoom In

O to zoom Out

W displays the shapes as Wireframes

S displays the shapes as Solid

The up/down/left/right arrows rotate the scene.
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The buttons at the top of the view also facilitate its handling (from left to right):

Button Action

enables to select whether the mouse should move the scene (button on the left)
or pick elements (button on the right), see details below.

resets the view and shows all the shapes of the scene ("R" key shortcut)

aligns the view along +X axis

aligns the view along -X axis

aligns the view along +Y axis

aligns the view along -Y axis

aligns the view along +Z axis

aligns the view along -Z axis

forces the refresh of the 3D view (recomputes the visualisation of all elements)

By default, as presented earlier, the mouse enables to move, pan and zoom inside the 3D view of
the system. By clicking on the Pick button presented in the table above, hovering the mouse over
the 3D viewer will focus the various elements of the scene, clicking with the mouse will select the
shape and move back to interaction mode.

On the top left of the 3D view, a drop-down menu allows the user to choose a model operation to
perform.

On the bottom of the 3D view, an information bar displays useful information about the current
selection: the number of selected elements as well as the size and the position of the bounding box
— the red box around selected elements. It is possible to click on the number of selected shapes to
display a list of the currently selected shapes.

Available geometric shapes

EDGE handles several primitive geometric shapes as shown below. Other kind of shapes are also
supported and presented in next section.

[All available shapes inside EDGE] | ../_images/all_shapes.png

Figure 15. All available shapes inside EDGE
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Available shape Non-handled shape

Box Polycone

Cone Segment Generic Polycone

Ellipsoid Polyhedron

Elliptical Cone Generic Polyhedron

Elliptical Tube Torus Segment

Orb Tube with Hyperbolic Profile

Paraboloid Cut Tube

Parallelepiped Twisted Box

Sphere Twisted Trapezoid

Trapezoid Twisted General Trapezoid

General Trapezoid Twisted Tube Segment

Tube Segment Extruded Solid

Arbitrary Trapezoid (Arb8)

Inside EDGE, a  button is available to show detailed schematics presenting the various
parameters for each shape.These schematics can also be found in Supported shapes schematics
annex

Other available shapes

EDGE is able to handle other types of shapes other than the plain CSG primitives presented in
previous section.

Assemblies

In EDGE, the user has the possibility to handle “assembly” elements.Those elements are grouping
several shapes without being attached to a geometric shape.

Assemblies are part of the GDML format but may not always be well-supported by numerical
kernels.


It is possible to remove all assemblies from the CAD by using the Reorganise model
tool.

Tessellated Solid

Solids with complex geometries can be constructed by importing tessellated surfaces, including
initially B-Rep based models. It is possible to import tessellated shapes by using the import function

available in the File › Import menu or inside the "Add new shape" dialogue.

Those tessellated surfaces are converted into an equivalent GDML tessellated solid object.
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Figure 16. Example of an imported tessellated solid



Please note that the imported tessellated surface must imperatively be a closed
surface. EDGE displays a warning message to the user if it is not the case.

Geometries imported from B-Rep models with the File › Import › Tessellated
geometry menu or with the [ Tessellated geometry ] option inside the "Add new
shape" dialogue are imported as a unique tessellated element.

To separate elements and have more controls on the import, see advanced import
options of the DeCADe additional plugin.

GDML file

EDGE also allows importing all the geometry concepts from another GDML file and including them
as a child of the currently selected element. This option can be very useful if users want to check
the position of a specific subsystem (defined in the imported GDML file) in the whole system (main
GDML file).

It is possible to import a sub-GDML file with the File › Import › GDML File menu or with the
[ GDML File ] option inside the "Add new shape" dialogue.
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Figure 17. Example of import of GDML file

Geometry edition

Creating and adding a new shape

The user has first to create a “world” shape that will include all subsequent shapes.

The position (0, 0, 0) corresponds to the barycentre of this world shape. Once this is done, it is
possible to start the construction of the desired object.



Note about the "World" elemnt

Even if technically GDML allows creating a world smaller than the final object, it is
not recommended.

The world shape typically corresponds to the computational domain of numerous
of simulation kernels using GDML files in input. Most of these tools will not work
properly nor give relevant results if the world shape does not encapsulate all other
elements.

The relevant definition of the world shape remains on the responsibility of the
user and with respect to the final targeted application.

Clicking on the  button opens the New Shape Wizard.

On the left panel of the dialogue box, all the available shapes are represented. A click on a shape
selects it and shows its properties on the right panel. Properties requirement varies with the
different shapes, but for each one the Name, Unit Configuration, Position and Rotation can be filled-
up. All the properties can also be edited via the Properties panel.
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Figure 18. New shape dialogue for a box

If the tree is empty, the first new shape will become the world shape. After that, each new shape
will be added to the tree as a child of the current selected element. If no element is selected, the
new element will be added as a child of the world shape. This feature makes possible the creation of
objects with a complex hierarchy of objects.

The new shape dialogue box displays all the available import options which may vary depending
on the installed plugins. Basic ones are the B-Rep format files import (.geo, .msh, .stl, .unv), or the
GDML file import.

Creating Boolean operation

Using the create Boolean operation button , it is possible to create Union, Intersection and
Subtraction directly in EDGE.

In order to create a Boolean operation, it is necessary to select two elements and click on the
button. The dialogue shown below will appear and let you choose a name for the Boolean
operation, which element is the first and which one is the second and finally the type of operation.
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Figure 19. New Boolean operation dialogue


The order of the two shapes in the operation is important for subtraction and
intersection only.

It is also possible to create directly a multi-union that groups more than two elements directly by
selecting three or more shapes and clicking on the create Boolean operation button. In this case,
only the name of the multi-union to create will be asked.

Material definition
The aim of this perspective is to define materials that will be attributed later to a geometric shape.

The Material definition perspective has no 3D view but is composed of three main panels, as shown
below.

• Top left: Materials list, the list of user-defined materials;

• Bottom left (collapsed by default): Available Geant4 Materials, the list of available Geant4
default materials;

• Right: Material editor, panel to edit the currently selected material.

Figure 20. EDGE material definition view
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About GDML materials

In GDML format, materials are defined by their isotopic and stoichiometry compositions.

Materials can be defined by a single “atom”, a composition of elements or fractions of elements.
These elements can be simple “atom” or represent an isotropic distribution.

The schema below presents different examples of material defined using the GDML formalism.

Figure 21. Material definition in GDML

Figure 22. Examples of different ways of defining materials in GDML

Materials list

Creating a material is performed by clicking on the  button.



Saving custom materials

A new material which is not attributed to a geometrical shape in the Materials
assignment perspective will not be saved inside the generated .gdml file when
saving the file in EDGE by default.

In order to save materials which are not attributed inside the .gdml file, it is
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necessary to activate the "write non-used user-defined materials" preference
which is disabled by default.

In order to edit a material, a click on an element in the list updates the material editor with the
current material where it can be edited.

It is possible to duplicate materials by selecting them in the list and clicking on the  button. The
new materials are added at the end of the materials list and their names are incremented in order
to not confuse them with the initial materials.

Deleting a selected material is performed by clicking on the  button.

By clicking on the  button, it is possible to import materials from another GDML file or from a
GDML materials XML file. In the case of a GDML file, this mechanism will import all materials
written inside the GDML file.

Finally, clicking on the  button exports the materials into a GDML material file (.xml). All the
user-defined materials will be exported.

Geant4 materials

Available Geant4 materials for the material assignment are displayed in the Geant4 materials
panel, on the bottom left of the perspective.

When clicking on the title, the pane is expanded to show the list of materials and their associated
density. By clicking on the header of the column, it is possible to sort the materials.

Figure 23. Table of available Geant4 materials and their associated density

Material editor

The material editor is separated in two main parts: the first one on the top is the same for every
material allows defining the name, the density and other properties of the material. Below, a
section enables to define the composition of the material and changes depending on the type of
chosen material.
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Screenshot below shows the editor for a simple “atom” material. On the top, it is possible to fill in
the material name, the density in g/cm3 and optional properties before choosing the type of
material.

Figure 24. Material editor for an "atom" material showing the optional properties

General optional material properties can be set by clicking on [ Show optional properties ] and
are:

• The choice of the atomic number Z (when atom is not selected);

• The formula;

• The state (liquid, solid, gaseous);

• The absorption length (AL);

• The mean excitation energy (MEE);

• The pressure (P);

• The radiation length (RL);

• The temperature (T).

The user can then choose a material type.
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Figure 25. Material editor for a composition of element (here water)

Screenshot above shows the material editor for a composition of elements.

These elements are similar to atom shown previously but can have additional meta-data attached
to them using the [ Show optional properties ] button. The number of each element is chosen on
the left with the “n” field. It is easy to add and remove elements just by clicking on the  button
and  respectively.

It is possible to define material with isotopes instead of elements. In this case each element is made
of fractions of isotopes.

Also, it is possible to define a material with fractions (percentage between 0 and 1) of
elements/isotopes instead of compositions.

To apply the modifications, it is necessary to click on the [ Apply modifications ] button.

Material assignment
The aim of this perspective is to apply the materials defined in the material definition perspective
to the geometry defined in the geometry edition perspective. Thus, this view only makes sense
when at least one shape has been defined in the geometry perspective.

The materials assignment perspective has the same 3D view as the geometry one.

• Top left: Material assignment tree, tree of the geometric shapes and the currently applied
material;

• Bottom left: Material assignment selector, panel to select the material for the currently
selected shape(s);

• Right: 3D viewer, 3D viewer highlighting the currently selected shape(s).
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Figure 26. EDGE material assignment view

Materials assignment tree

This panel contains a tree-table with two columns.

The first column (on the left) shows the tree of geometry shapes created in the Geometry edition
perspective.

The second column (on the right) indicates the material attributed to each corresponding geometry
shape. By double-clicking on the right column, it is possible to directly change material assignment
without using the material selection panel.



Default materials

By default, the Geant4 material 'G4_Galactic' (i.e. space environment) is attributed
to the geometry shape representing the world. All other geometry shapes created
are, by default, composed of 'G4_Aluminium'.

This behaviour can be changed in the Preferences.

On the top of the tree-table, controls help in various ways to locate and select visibility of elements.

Button Action

Searches the tree-table for the shape with a name containing the text entered in the
search field next to it. Once a search has been made, the tree-table will be filtered on the
found elements, click again on the search button to clear the search and display the
whole tree-table again.

Expands/collapse the whole tree-table to see more or less shapes.
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Button Action

Enables to change the visibility of all shapes in the tree-table: if most shapes are visible,
it will hide all shapes, otherwise it will display all shapes.

Material selection

The Material selection panel allows the user to select the material to attribute to a geometry shape,
defined in the Geometry edition perspective.

Figure 27. Material selection panel

When at least one geometry shape is selected in the Materials assignment tree, the panel displays
several choices of material for the user to choose in the list below:

Pre-defined materials:

Predefined Geant4 materials that can be directly used to assign the material.

Custom materials:

This option is only available when there is at least one custom material defined in the material
definition perspective.

The choice updates the content of the drop-down list with either the pre-defined materials or the
custom ones.


It is possible to filter the drop-down list by typing letters on the keyboard. For
instance, typing a  +  l  +  u  will filter the list with materials having "alu" in the name
(not taking into account the case).

When the chosen material is selected in the drop-down list, the modification must be saved by
clicking on the [ Apply ] button. The [ Cancel ] button reset the material assigment to the initial
value.

GDML File
EDGE provides a rich text-editor to complete the capabilities of the other perspectives and let the
user freely edit and extend the generated GDML file currently loaded in EDGE.

The perspective is dedicated to this editor shown below.
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Figure 28. EDGE GDML file perspective

File edition

A rich text-editor shows how the GDML file would be generated on disk. The content of the editor is
updated each time the perspective is opened.

It is possible to modify the GDML file directly by editing the generated content.

Once modification performed, it is possible to reload the file into EDGE (to see the modifications in
the 3D view for example) using the [ Save & Update EDGE ] button but it is also possible to save the
produced content to somewhere else on the disk by using the [ Save as… ] button.



Be aware, that when reloading your modification into EDGE, it will be
reinterpreted by the software and if you switch back to the GDML file perspective,
its content will be re-generated from EDGE data-model and thus may have a
different syntax but will represent the same system.

This editor provides a syntactic colorization and completion. Completion is available by typing the
ctrl  +  space  key combination.


This perspective is disabled in trial mode of EDGE and you need the full version of
EDGE to use it.
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Model operations
The user can perform operations on the created CAD model thanks to the [ Model operations ]
drop-down menu or inside the Tools menu. The list of available operations may be subject to
changes depending on installed additional modules.

The following operations are always available in EDGE.

Check for overlaps
This operation allows the user to check if there are no overlaps inside the geometry, meaning that
there are no shapes overlapping each other.

It is possible to choose if "touching" shapes should be considered as overlapping or not. To launch
the calculation, the user can click on the  button. The  button allows the user to stop the
calculation at any time.

Figure 29. Overlaps calculation results (indicates that several shapes are overlapping with the
LeftPanelRight shape)

By clicking on the [ Export results to CSV file ], it is possible to save the list of overlapping shapes
to a .csv file.

Compute surface
This operation allows the user to obtain the surface of the various elements of the geometry. The
computed value is an approximation of the real surfaces value based on 3D meshing of the shapes.
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Figure 30. Surface computation results

By clicking on the [ Export results to CSV file ], it is possible to retrieve the computed results to a
.csv file.

Compute volume
This operation allows the user to obtain the volume of the geometry. The computed value is an
approximation of the real volume value based on 3D meshing of the shapes.

Here also, it is possible to retrieve the results into a CSV file.
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Figure 31. Volume computation results



Computation function limited capabilities

Computation of volume (and thus mass) may take quite some time over complex
systems. This is an indicative tool to check consistency with real system.

Take care with this tool on complex systems.

Reorganise model
This operation allows the user to reorganise the model following several options. The tool computes
the new hierarchy, displays the results to the user and proposes to modify the model accordingly

Hierarchical

Checks the consistency of the hierarchy of the model. Indeed, to get proper radiations results,
elements that are included in other ones (geometrically) should be placed as child of the
geometrical shapes they are in. This option computes the real hierarchy.

Sort A-Z

Sorts the children of each element by alphabetical order.
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Sort Z-A

Sorts the children of each element by reverse alphabetical order.

Figure 32. Example of hierarchy reorganisation results



Removal of logical assemblies

The Hierarchical option will remove all assemblies from the model as they do not
have a physical representation that can be used to find the real hierarchy of
shapes.

As some code may not handle well assemblies, this tool can be used to
automatically remove these assemblies.

Validate GDML file
This operation checks the syntax validity of a GDML file against the GDML file format
specifications. It is possible to check the current file (if saved beforehand) or any file from the
system.

It is possible to select the wanted GDML file version used to check the XML validity of the file.
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Figure 33. GDML file validity check tool
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Plugins

SSAM plugin



Access to this plugin requires an additional licence and/or depends on your EDGE
licence. Contact the SpaceSuite team for more information.

The installation procedure is detailed in the Tools menu description.

SSAM is used to perform a sector shielding analysis on the CAD model in EDGE. Using a ray-tracing
technique, SSAM will perform, from a target point of view, an evaluation of the shielding thickness
in all directions of a selected angular sector. The target can typically be a sensitive device on which
the user wants to evaluate radiations effect. Taking into account the nature of attributed materials,
the geometrical thickness is converted into aluminium effective one.



In order to use SSAM, the geometry must be properly defined and materials
assigned to it. A properly defined geometry does not contain overlaps. SSAM also
check if there is no overlap in the geometry to avoid problems during the
calculations. If it detects overlaps, the computation will stop with a message
explaining it.

Additionally, after computing the sector shielding analysis, SSAM is able to compute the dose
received by the target. To do so, it is necessary to compute beforehand the dose versus depth of
aluminum curve to provide to SSAM for the wanted environment. Then the equivalent thickness of
Aluminium of each sphere sector and the dose versus depth tabulated function are used to compute
the deposited dose using the formula below, where \Omega_i is the surface of the sphere sector i,
D(T_i) is the dose for the equivalent thickness of Aluminium of the sphere sector i:

Total \ dose = \frac{1}{4\pi} \sum_{i}^{sectors} \Omega_i D(T_i)



Limits of the sector shielding analysis approach

The sector shielding analysis approach implies the particle transport through the
matter be averaged as straight lines from the sources to the target, without
scattering, diffusion nor secondary particles emissions.

This may constitute a severe assumption is some cases, like for electrons diffusion.
Moreover, the position of the punctual target, as defined in SSAM, may deeply
impact the effectively viewed shielding, i.e. effect of point-of-view, and the total
cumulated dose of a larger sensitive component, with a spatial extension, be
significantly differ.

For these reasons, results computed with a sector shielding analysis should be
considered with care and remain of the full responsibility of the end user and his
expertise.

Two modes of operation exist in SSAM:
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SSAM Single mode

the sector shielding analysis is performed at one location, and can optionaly be followed by a
dose computation. The sector shielding analysis results can be viewed in different manners
(such as histograms or 3D represention). This mode is available via the [ SSAM [Sector
Shielding Analysis Module] ] entry.

SSAM Multi-position dose

a complete dose analysis is performed at several locations inside the geometry. Dose results are
directly provided for all selected positions. It is also possible to visualise detailed results (like for
single mode) for one position at a time. It is available via the [ SSAM Multi-Position Dose ].

SSAM Inputs

To compute the sector shielding analysis SSAM needs various parameters in addition to the CAD
definition. These parameters are quite the same whatever the mode, there are then presented here.
Specific information for parameters for each mode are provided in the subsections.

General parameters

Position

It is necessary to select a position where to perform the sector shielding analysis. It is
represented as x, y, z and a length unit for the position. The  button enables to define
position easily, see Position parameters.

Sphere sectors

It is needed to provide a number of sphere sectors to divide the space in theta(θ) and phi(φ)
directions — with theta varying between 0 and 2π and phi between 0 and π.

Emitted rays

The total number of rays to launch for the sector shielding analysis.

From the defined position, the selected number of rays is launched in all directions (using an
isotropic distribution). SSAM computes the distance in each material density type crossed by the ray
and calculates the equivalent thickness of Aluminium defined by a density of 2.699 g/cm^3.

All these results are then summarised for each sphere sector computing the minimal, mean and
maximal of the equivalent thickness of Aluminium.

Position parameters

There are several solutions to select position where the computation will happen. The following
details how to set up one positions, more details on handling of several positions and parametric
positions are provided in SSAM Multi-position dose section.
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Figure 34. Create single position dialogue

The above dialogue is shown to help define input position for SSAM analysis. It enables to select a
shape from the CAD definition (a real shape, assemblies cannot be used in this case). Once a shape
is selected, it is possible to select simple position within the shape, the following options are
possible:

• at the shape centre (so its defined position)

• on its surface at -X, +X, -Y, +Y, -Z or +Z.

When [ OK ] is clicked the selection is converted to the X/Y/Z position to be used.

Dose parameters

As noted before, to perform a dose computation, users must beforehand compute the tabulated
function defining the evolution of the cumulative dose versus the depth of a material, using
external software, models or experimental data for the wanted environment. The user may, for
instance, use the Shildose2 model, as provided in the frame of the ESA/BIRA/Spenvis online
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application.

Then it is possible to set the needed parameters for dose computation:

Dose versus depth curve

It is possible to set it manually directly in the editor or to load a CSV file with two columns

separated by a comma (to do so, go to File › Load). The first column defines the depth and the
second one the dose. An example of such file is provided in the CSV file for dose example annex
and also in the data directory of EDGE.

Depth unit

The depth value (first column) unit must be set between g/cm² or millimetre of a material with a
specific density for the depth. If the selected unit is g/cm², then it is not necessary to set the
density because the results do not depend on the density of the material.

Dose unit

The dose value (second column) must be set between Gray or Rad.

As shown below, the selected parameters are dynamically interpreted to display on the right part of
the editor the points of the tabulated function.
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Figure 35. Dose parameters view

SSAM Single mode

In single mode, at startup it is needed to provide one position, the number of sectors and rays as
presented in previous section. Then click on [ Play ] button to launch SSAM.

39



Figure 36. Inputs parameters for SSAM in single mode

SSAM results are displayed after all the rays are launched.

There are several areas to display SSAM results as illustrated below.

Figure 37. SSAM results

Left

Lists the 3D results elements and allow to change their visibility, transparency and colours by
clicking on the corresponding checkboxes and coloured buttons. By default, the modelling
geometry is displayed in transparency and in black colour. The position of the target is
represented by a red sphere. Please note, in some cases, this sphere can be small compared to
the global geometry size and a zooming might be needed to see it.

Centre

3D view of the different results computed with SSAM.

Right

Table with 4 columns and several rows. Each row is the result of a sphere sector defined by a
division in theta and phi directions described by the input parameters. The columns are
respectively the mean, the minimum, the maximum and the standard deviation of the mean
values of the equivalent thickness of aluminium in this sphere sector. All these values are
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expressed in metre.

The standard deviation is computed with the formula below, where nb_{rays} is number of rays
launched in the sphere sector, t_{i} is the equivalent thickness of the ray i and t_{mean} the
mean of all equivalent thicknesses in the sphere sectors:

deviation=\sqrt{\frac{\sum_{i=1}^{nb_{rays}} (t_i - t_{mean})^2}{nb_{rays} - 1}}

Top right

The contextual menu bar provides several possibilities to display the selected results in the 3D
view or as plots, export them into CSV format files or to compute the dose received by the target.
More details on these actions are available in the next section.

3D results

The  button menu allow to display results in the 3D view. The selected result appears in the
3D view and is listed in the control panel.

The following 3D representations are available:

• The minimum, mean or maximum of the equivalent aluminium thickness for each sphere
sector. More information about each sphere sector can be obtained by clicking on each sphere
sector item in the list of 3D items;

Figure 38. 3D sphere sectors results or "hedgehog view"

• The average sphere considering the mean of the equivalent aluminium thickness for all rays
launched by SSAM. The details regarding this sphere, like the diameter can be displayed by
clicking on the item in the list of 3D items.

The information bar at the bottom of the 3D view gives the size of the selected element
bounding box enabling to quickly access the size of the sphere;

• The number of interceptions for each face of the geometry. This 3D result can be used to check if
enough rays have been launched to provide a statistic good enough: if a face has zero
interceptions, it indicates that not enough rays has been launched to intercept this face.

When selecting this results in the list of 3D items, a scalar bar appears helping assess the value
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represented by each colour;

Figure 39. Number of intercepting rays for each face

• The minimum, mean or maximum hollow sphere sectors of equivalent aluminium thickness.
Users must set the inner radius of the hollow sphere, and the space between each sphere sector.
The details of each hollow sphere sector are available by clicking on each sphere sector item in
the list of 3D results.

Figure 40. 3D hollow sphere sectors results

• A coloured sphere where each colour represents the value of the equivalent thickness of
Aluminium in metre.

When selecting this results in the list of 3D items, a scalar bar appears helping assess the value
represented by each colour.
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Figure 41. Sphere sector aluminium equivalent thickness mapped on a coloured sphere

Plot results

The  button menu enables to display plots of meaningful results into a pop-up window.

The following results are available:

• y = f(x) chart type where the minimum, the mean and the maximum of the equivalent
thickness of Aluminium in metre for each sphere sector is displayed.

Figure 42. Minimum, mean and maximum equivalent thickness of Aluminium in metre for each sphere
sector

• y = f(x) chart type with the mean of the equivalent thickness of Aluminium in metre and its
standard deviation are displayed for each sphere sector.

43



Figure 43. The mean of the equivalent thickness of Aluminium and its standard deviation in metre for
each sphere sector

• A 2D Map showing the angular repartition of the equivalent thickness of Aluminium for each
sphere sector.

Figure 44. Angular repartition of the equivalent thickness of aluminium in metre for each sphere sector

Export options

The  button menu enables to save the following results on the disk:

• The equivalent thicknesses of Aluminium in metre to a CSV file;
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• An equivalent sphere with a radius equal to the average of the equivalent thicknesses of
Aluminium of all rays used for SSAM.

This sphere is exported to a GDML file;

• The number of rays which intercepted each face of the geometry in a VTK file;

• The hollow sphere sectors using the minimum, the mean or the maximum of the equivalent
thickness of Aluminium of all sphere sectors.

The hollow sphere sectors are exported to a GDML file.

Users must set the radius of the hollow sphere, and the space between each sphere sector to
avoid cross contacts and overlapping between sectors to respect GEANT4 constraints.

Dose computation

The  button enables to compute the cumulative dose based on the previous
computed aluminium equivalent thicknesses.

When clicking on it, the Dose parameters window appear.When the inputs parameters for the dose
computation are set, users can click on the  button to launch the computation.

Then a new popup appears with the results of the cumulative dose.The results are computed
considering the minimum, the mean and the maximum of the equivalent thickness of Aluminium
for all sphere sectors.

Users can choose to save these results in a dedicated file by clicking on the  button.

SSAM Multi-position dose

In multi-position mode, at startup it is needed to provide the positions, the number of sectors and
rays as presented in previous section and the dose-depth data.

Figure 45. Inputs parameters for SSAM in multi-position mode

To set the positions, click on the [ Select positions ] button. It will open the multi-position selection
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dialogue where the positions can be selected.

Figure 46. Positions selection dialogue

In this dialogue, positions can be easily added with  or removed with .

When adding a new position, a new dialogue appears to select a position as presented in Position
parameters. An additional tab is present to add parametric positions as presented below.

Additionally, the [ Load positions from CSV ] button enables to load the positions from a given CSV
file. This file must have with three columns for x, y, z. When clicking the button, a small pop-up as
shown below appear to select the file, the element separator inside the CSV file as well as the
position unit.
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Figure 47. Load from CSV pop-up

Parametric positions

When computing several positions with multi-dose, an additional tab is available to select
parameteric positions.

Figure 48. Create a parametric position panel

Once a shape is selected, there are several options to create positions from a shape with parametric
options.
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
To improve automatic results, it is recommended to use parameteric options for
two axes maximum and fixed on one axis at least.

When the  button is selected, for each axis the available options are similar that one
position ("lower" surface, centre and "upper" surface). An additional option enables to provide a
custom location along the axis.

When the  is selected, two options are possible:

Step size

The provided value indicates the step between two successive points on the current axis. A
chooser enables to select the unit of the step value.

Number of points

The provided value is the total number of points that will be created along the axis.

Taking into account all the provided values and the shape, the final positions will be created. For
parametric values, the first position will be located at step/2 from the minimum size of the shape
on the given axis. All possible points using the provided parameters will be created.

Run multi-dose and results panel

Then click on [ Play ] button to launch SSAM for each selected position. If numerous positions are
set up, the computation can take some time to finalise.

All dose results are displayed after all the rays are launched for each position.

Figure 49. Results panel for SSAM in multi-position mode

The first column provides a name for the position indicating how it was computed, the next three
columns display the selected position x, y and z components in metre. The last three columns
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present the dose results with the minimum, mean and maximum dose for the selected position.

By selecting a specific line of the table, it is possible to see detailed results with [ Visualise detailed
results ]. It will display the same interface as the single mode result.

If a parametric position was set up, it is possible to visualise summary results by clicking on
[ Parametric results ], select the wanted parametric result and whether results should be
displayed for min/mean/max thickness of material. If one axis was set up as parametric, the result
will be a XY plot, otherwise, for two axis, the result will be displayed as a 2D colour map. It is not
possible to display such results if all axis are parametrised.

As for single position, it is possible to export the results to a CSV file by clicking on the [ Export to
CSV ].

DeCADe plugin



Access to this plugin requires an additional licence and/or depends on your EDGE
licence. Contact the SpaceSuite team for more information.

The installation procedure is detailed in the Tools menu description.

DeCADE, for Detesselator and Extended CAD importer, is an EDGE-plug-in providing extended
STEP-AP format capabilities and a set of geometry simplification and clean-up features to adapt the
imported geometry to radiations analysis.

Needed system configuration

The Smart STEP-AP importer needs a special configuration to work, otherwise you will see the
following error message appear at startup:

Environment variable "MMGT_OPT" not set to 0, unable to load
OpenCascade.

Check application user-manual for more information.

The MMGT_OPT environment variable controls memory management settings. You can configure it in
two ways:

1. System-wide setup (always active).

2. Launcher script (only active when starting the application through a helper script).

System-wide Setup

Linux (bash, zsh, etc.)

1. Open a terminal.

2. Edit your shell configuration file (~/.bashrc or ~/.zshrc):
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nano ~/.bashrc

3. Add this line at the end:

export MMGT_OPT=0

4. Apply changes with:

source ~/.bashrc

macOS

Steps are the same as Linux:

1. Open Terminal.

2. Edit your shell configuration file (~/.zshrc by default):

nano ~/.zshrc

3. Add:

export MMGT_OPT=0

4. Reload:

source ~/.zshrc

Windows

1. Press Win  +  r , type SystemPropertiesAdvanced, and confirm.

2. Click Environment Variables…

3. Under System variables, click New:

◦ Variable name: MMGT_OPT

◦ Variable value: 0

4. Confirm with OK and restart your computer (or log out/in).

Launcher Script Setup (per-application only)

If you want to keep environment changes local to your application, use one of the following scripts.
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Linux

Create a script bin/launch.sh:

#!/bin/sh
export MMGT_OPT=0
./edge "$@"

Make it executable:

chmod +x launch.sh

Run with:

./launch.sh

macOS

Create launch.command:

#!/bin/zsh
export MMGT_OPT=0
./edge "$@"

Make executable:

chmod +x launch.command

Double-click launch.command in Finder, or run it from Terminal.

Windows

Batch (.bat)

Create launch.bat in the same folder as application.exe:

@echo off
set MMGT_OPT=0
edge.exe %*

Start the app by double-clicking launch.bat.

PowerShell (.ps1)

Create launch.ps1 in the same folder as application.exe:
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$env:MMGT_OPT = "0"
Start-Process -FilePath ".\edge.exe" -ArgumentList $args -Wait

Run with:

.\launch.ps1

If you see a script execution policy error, you may need to enable script execution in PowerShell by
running:

Set-ExecutionPolicy -Scope CurrentUser -ExecutionPolicy RemoteSigned

Recommendation

• Use system-wide setup if you want MMGT_OPT=0 always in effect.

• Use a launcher script if you only need the variable when starting this specific application.

Smart STEP-AP importer

As any importer, the Smart STEP-AP importer is available in the File › Import menu or inside the
"Add new shape" dialogue.

The extended STEP-AP importer allows to:

• Import STEP element by element (i.e. shell by shell) when the [ Separate elements ] check-box
is selected

• Sort elements by size when imported in EDGE to facilitate the removal of small elements by
checking the [ Ascending sort by size ] check-box.

• Fill automatically any hole that might be present inside the imported tesselated element by the
checking the [ Automatically fill holes in imported mesh ] check-box.
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Figure 50. STEP-AP import dialog preview

The screenshot below presents an example of imported STEP-AP file (a Raspberry Pi card) inside
EDGE using the DeCADe smart importer.

Figure 51. Example of imported STEP-AP file in EDGE

Detessellation operation

After importing a STEP-AP, or any other meshed/b-rep based format, the geometry is made of
tessellated elements that cannot be edited and induce more CPU cost when performing Geant4
analysis.

DeCADe offers a function called "Detessellator" that enables to convert tessellated elements into
CSG primitives fully compatible with GDML. To use this function, after selecting the elements who
want to detessellate, click on the  button in the toolbar on top of the list of shapes.

A new dialogue appears to select a few options:
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[ Separate non-continuous shapes ]

This function will detect in the tessellated element if there are non-continuous surfaces that
represents two different shapes. Then it will create a shape per different continuous surface. If
not selected, the tessellated element is considered as only one element. It is recommended to keep
this option active.

[ Automatic shape detection ]

The algorithm detects automatically which primitive is closer to the selected element between
Boxes, Cones and Spheres. If not selected, you must choose by which primitive the tessellated
shape will be approximated. The available shapes are then Box, Cone, Cylinder, Ellipsoid and
Sphere.

The screenshot below presents an example of detessellation, here on an embedded computer
mother board from an initial STEP-AP file in a cubesat. The left view shows the initial import as
triangulated surfaces. The right-side view shows the equivalent pure CSG / GDML model. All
components have been automatically detected and converted by the detesselator.

Figure 52. Example of detessellation: tessellated elements (left) versus GDML primitives obtained with
DeCADe (right)

In most of the usual cases, canonical shapes can be automatically detected, sized and located or, for
the most complex cases, can manually be pre-identified by the user through the GUI.

IC Meshing Plugin


Access to this plugin is free of charge, the installation procedure is detailed in the
Tools menu description.

Volume Mesh Creation for Internal Charging Analysis, in short Internal Charging Meshing or IC
Meshing, is an EDGE plugin developed to widely facilitate the creation of scoring volume mesh used
in the SpaceSuite internal charging modelling chain.

First, this modelling chain needs the CAD of the system from a GDML file created, for example, with
EDGE. This file is then used by MoORa to compute the interactions between the particles coming
from the space environment and the materials.

During this computation, both the deposited dose and charge are scored in a volume mesh used
later in the modelling chain as initial condition for SPIS-IC to compute the internal charging effect
in the dielectric.
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The purpose of the Internal Charging Meshing EDGE plug-in is to compute this volume mesh where
both the deposited dose and charge will be computed later by MoORa.

Standing for Modelling Of Radiations, MoORA is a user-friendly and simple to use software
developed by Artenum that helps modelling the radiations transport using Geant4, a Monte-Carlo
numerical kernel.

Internal Charging Meshing provides tools for GDML manipulation to: select the dielectrics we want
to study; move elements relatively to each other and merge common surfaces between elements.
Then, an easy-to-use mesh editor generates a volume mesh, which can be anisotropic depending on
the user needs.

Internal Charging Meshing starts from a GDML file used for Geant4 analysis. The hierarchy of the
GDML geometry must be consistent with the Geant4 requirements. The volume mesh to create will
be saved on the disk in a .msh Gmsh mesh file. The volume mesh to create is the input CAD file for
the SPIS-IC simulation. It is usually the dielectric we want to study where the surface continuity has
to be guaranteed. Finally, the Internal Charging Meshing plug-in creates a MoORa project where the
CAD model is the GDML file defined in EDGE, the particle source is a sphere surrounding the
geometry, with a cosine-law angle distribution and electrons at 1MeV and both the deposited dose
and charge will be computed on the scoring volume mesh.

The plug-in is available from the "model operations" drop down menu. If users want to create a
complete .moora project, the GDML CAD file needs to be finalized before to use the plugin.

Home

At the launching, the Internal Charging Meshing opens the Home perspective  of the plug-in a
new window, displaying two icons:

Only available if a geometry is present in EDGE. Choosing this option loads the current GDML
geometry, except the world element and goes to the next step.


The hierarchy of the GDML geometry must be consistent with the Geant4
requirements: a shape containing another shape must be the parent of this
shape in the data tree model.

Always available, it allows importing previously designed B-Rep geometries. Choosing this
option sends directly to the Mesh creation perspective (see Mesh creation).

 Imported .geo file cannot be modified inside the application.

Subsystem selection

Subsystem selection perspective ( ) is dedicated to the selection of the GDML subsystem we want
to study.
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Its interface is divided in tree part, as it can be seen below:

• Left bar: Perspective selector to navigate between the different perspectives;

• Left: Subsystem selection panel, detailed in the next paragraphs;

• Right: 3D Viewer provides a 3D view of the complete GDML model.

Figure 53. Subsystem selection perspective

In the subsystem selection interface, all the GDML elements are listed. This list can be expanded
 or collapsed  by clicking on the corresponding icons.

Relevant GDML elements must be selected in the subsystem selection interface. They can be
selected or unselected individually. Moreover, click on  to select all the elements, while 
cancels the whole selection. Selected elements are coloured in green inside the 3D viewer.

Users need to select a sub-system with only one parent elements containing all other ones. So,
if a single Gdml element is selected, sub-system selection can be directly validated (clicking on
[ Validate sub-system selection ]).

Otherwise, if several elements are selected without a unique selected parent, the user has to
create an external volume including all the selected shapes ([ Add external volume ] button).
The shape of the new external created volume is necessarily a rectangular parallelepiped and can
differ from the world element defined in the standard EDGE interface. Nevertheless, it has to be
included inside the world element defined in EDGE. The default dimensions of this volume at its
creation are the minimal values to entirely contain the internal elements. This external shape can
be reshaped and repositioned using the x, y and z size and position fields visible on figure above.
The new shape is validated by clicking on [ Apply changes ].

When the external volume is well shaped, the user can pass to the next perspective by clicking on
[ Validate sub-system selection ].
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Put solids in contact

The objective of this step is to put in contact shapes with other shapes. It is necessary because the
GDML CAD model respects the GEANT4 numerical kernel constraints (especially shapes must not be
in contact with other shapes neither overlapping) but in SPIS-IC numerical kernel, constraints
regarding the geometry are different: the shapes which are really in contact must also be in contact
in the geometry (to allow the charge to move from one shape to another one by conductivity).

This is why, it may be necessary to put shapes from the initial GDML model in contact with other
shapes. Depending on the study, this operation is not mandatory.

The Put solids in contact perspective interface ( ) seems quite similar to the Subsystem selection
perspective, as it can be seen below. It allows to move GDML elements between each other to put
them in contact.

An element can be selected as:

A target

Single target is defined for each move. It is the motionless reference element of the put in
contact.

 The selected target is coloured in yellow in the 3D viewer.

Move shape(s)

Several move shapes can be defined simultaneously for a move.

 Move shape(s) are coloured in green in the 3D viewer.

Figure 54. Put in contact perspective

Next, the move direction of the move shape has to be defined.

Two ways can be used to choose this direction:
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• The quick definition icons [ + ] / [ - ] and [ X ] / [ Y ] / [ Z ] allow to define a move direction
parallel to one of the director vectors of the 3D geometry.

The selected direction is displayed in the field below.

• Alternatively, the move direction can be defined freely in the input fields by selecting on
[ Custom ] or by directly editing the content of X/Y/Z fields.

When the target, move shapes and direction motion are correctly defined, the modification can be
applied by clicking on the [ Move shapes ] button . Previous motions can be canceled with the 
button to go back to the initial state.



Limiting motion of GDML shapes

If the length of the motion is greater than 1 µm, a warning message is displayed.

Indeed, moving the shape is a modification regarding the GDML geometry used by
the Geant4 numerical kernel. Move shape with a distance too big will lead to
unexpected scoring Geant4 simulation results where the scoring volume mesh and
its corresponding GDML shape are in two different positions.

This warning will not be displayed for the created external volume because it is an
empty volume with no shape defined in the GDML CAD model.

When all the desired motions have been realised, click on [ Validate move and generate merged
geometry ] to go to the next perspective.


The put in contact tool is actually not able to merge the edges from different GDML
elements.

Mesh creation

The Mesh creation perspective  provides a tool to generate a Gmsh mesh. This mesh may be
computed with strong anisotropy if necessary.

For the study of the effect of internal charging, the volume mesh on the dielectrics will be used to
score both the deposited dose and charge rates with Monte-Carlo simulations. Ideally, the volume
mesh would have small tetrahedra in all directions to have a good modelling of the internal
charging effects. Nevertheless, the CPU time of the Monte-Carlo simulations can be long to reach a
good statistic in all of these tetrahedra. The objective is to reach a good ratio between the size of the
tetrahedra and the CPU time which will keep internal charging results accurate enough. The
smallest the number of tetrahedra in the volume mesh is, the shortest the CPU time will be.

To minimize the number of tetrahedra in the volume mesh of the dielectric one solution is to have
small tetrahedron size in the direction where the electric field and potential will change quickly
and bigger tetrahedron size in other directions. In some situations, like high voltage dielectric card
for example, strong anisotropic volume mesh needs to be computed.
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Figure 55. Mesh creation perspective

Mesh can be generated from:

• the GDML subsystem designed in the chain detailed in the two previous sections. The generated
geometry is a Gmsh .geo file. Both surfaces in contact and volume with other volume inside it
have been "smartly" computed by creating surfaces and volumes with holes to be consistent
with the SPIS-IC numerical kernel constraints regarding the geometry;

• an external .geo file loaded by clicking on the [ Import .geo file ] icon.

[ Export … ] icon enables to export the geometry to a Gmsh .geo v2 or v4 file.

The mesh element size is governed from the X/Y/Z anisotropy coefficients fields, where the tile size
is written in meters.

In order to generate a mesh with a sufficient resolution, an anisotropy coefficient size have to be a
fraction of the sensitive element size following the concerned direction. If an anisotropy coefficient
size is greater than the dimension of a shape, this shape will be mesh with the coarsest possible
cells.

To facilitate the choice of Anisotropy coefficient size, the 3D viewer of the mesh creation
perspective presents several functionalities.

Button Action

allows moving and turn the viewer

allows to select a shape of the geometry in the 3D viewer. The shape is highlighted
in the list.

drop-down menu regrouping the same icons as EDGE to align the 3D view with
the X/Y/Z axis

drop-down menu that allows to choose the transparency of all the surfaces

displays the surface of the shapes
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Button Action

displays the surface of the shape and the edge of the mesh

displays only the mesh edges

Surfaces displays all the surfaces of the geometry in the shape list

Physical
Surfaces

displays in the shape list the Gmsh physical surfaces where specific properties
will be applied in SPIS-IC

Volumes displays the volume of the geometry ranked by their id number in the shape list

Physical
Volumes

displays in the shape list the physical volume of the geometry ranked by their
name where will be applied in SPIS-IC specific properties (for example the
material properties)

In the shape list on the left side of the perspective, each item can be selected or unselected which
will change the visibility of the shape in the 3D view and will not impact the mesh creation.

Moreover, selecting a shape displays this dimension in the bottom of the 3D viewer. That can be
helpful to correctly choose the anisotropy coefficients.

By clicking on the colour box of each item, the colour shape of the selected item will be changed in
the 3D view according to the new selected colour.

When the field are correctly filled out, the mesh can be created by clicking on [ Compute mesh ].

Mesh checking and export

The last perspective , which can be seen below, allows to check and export the GDML subsystem
and the Gmsh mesh to a MoORa Project.

Figure 56. Checking and export interface

The 3D viewer interface of this perspective is very similar to the previous one. It allows checking
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visually the mesh by modifying the 3D viewer option as it can be seen below.

Figure 57. Example of anisotropic mesh visualisation

When the check is complete the geometry and the mesh can be export by clicking on [ Export to
MoORa project ], or the mesh can still be modified by returning to the previous perspective .

MCNP Plugin



Access to this plugin requires an additional licence and/or depends on your EDGE
licence. Contact the SpaceSuite team for more information.

The installation procedure is detailed in the Tools menu description.

MCNP Import

As any importer, the MCNP importer is available in the File › Import menu or inside the [ Add new
shape ] dialogue.

The importer tries to identify CSG shapes from the cell definition inside the provided MCNP file.
The importer only imports elements related to the CAD definition: the cells block and surfaces block
are imported and from the data block, only the materials (M) and the transformations (TR and TRCL)
are interpreted.

Concerning the surfaces, the macro-bodies RHP/HEX, ARB and WED are not converted and the surfaces
GQ, SQ, TX, TY, TZ, X, Y, Z are not interpreted.

Simple cell definitions are directly interpreted, otherwise a Boolean operation of the surfaces is
created in EDGE. However, the following constructs are identified by the importer and the
corresponding native GDML elements are created:

Cell content GDML shape

6 orthogonal planes Box

Infinite cone + 1 plane Cone Segment

Infinite tube + 2 planes Tube Segment


Complement operations (like #1) are ignored by the importer: they mostly describe
in GDML terms a parent/child relationship which is implicit inside the GDML.
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MCNP Export

The MCNP plugin can also export the GDML definition to a MCNP file.

The following GDML shapes are exported to MCNP:

GDML shape Note

Box

Cone Only if rmin1=rmin2=0

Ellipsoid Only if ax=by

Orb

Sphere Only if deltaphi=360° and deltatheta=180°

Tube

Intersection

Subtraction

Union

Moreover, the default Geant4 materials cannot be exported to MCNP and will be replaced by void
material. Ensure to define properly your materials beforehand.
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Annexes

Supported shapes

Note on the Thickness parameter and Boolean operations

Some elements — such as boxes, ellipsoids, orbs, parallelepipeds and trapezoids — have an
additional useful parameter inside EDGE (not present in GDML) called thickness. If a shape
has a thickness defined (different from 0), then the export of this shape will be done using
Boolean operations (a subtraction between the outer element and the inner element). It
allows the user to gain time for this kind of operation.

This kind of shape can be very useful during the definition of radiation analysis. The user
shall be aware that this thickness value is not a GDML parameter, which means that setting
this parameter to a value different from zero will result, in the GDML file, to the
corresponding Boolean operation. The little warning sign next to the name of this parameter
is present to remind the user of this.

If an EDGE file containing a shape with a defined thickness (different from 0) has been saved
and is then loaded again, EDGE will try to reload it correctly as the initial shape with
thickness and not as the Boolean operation saved in the file.

Box parameters

Cone parameters
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Ellipsoid parameters

Elliptical cone parameters
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Elliptical tube parameters

Orb parameters

Paraboloid parameters
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Parallelepiped parameters

Sphere parameters

Trapezoid parameters

66



General Trapezoid parameters

Tube parameters
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Example of materials
Here after is presented an example of material definition in GDML format (partial description).

<materials>
    <!--   Examples of basic or fundamental materials -->
    <element name="videRef" formula="VACUUM" Z="1">
        <atom value="1"/>
    </element>

    <element name="aluminum" formula="Al" Z="13">
        <atom value="26.9815"/>
    </element>

    <element name="carbon" formula="C" Z="6">
        <atom value="12.0107"/>
    </element>

    <element name="Hydrogen" formula="H2" Z="1">
        <atom value="1.01"/>
    </element>

    <element name="Nitrogen" formula="N2" Z="7">
        <atom value="14.01"/>
    </element>

    <element name="Oxygen" formula="O2" Z="8">
        <atom value="16.0"/>
    </element>

    <!--   Examples of complex or composite materials -->
    <material name="Mat_ALUMINUM" formula="ALUMINUM">
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        <D value ="2.7000" unit="g/cm3"/>
        <fraction n="1.0000" ref="aluminum"/>
    </material>

    <material name="Mat_Kapton" formula="Kapton">
        <D value ="1.42" unit="g/cm3"/>
        <fraction n="0.0273" ref="Hydrogen"/>
        <fraction n="0.7213" ref="carbon"/>
        <fraction n="0.0765" ref="Nitrogen"/>
        <fraction n="0.1749" ref="Oxygen"/>
    </material>
</materials>

CSV file for dose example
Here after is presented an example of csv file defining the dose in Rad versus the depth in g/cm2 in a
tabulated function for the dose computation.

The first column is the depth and the second column is the dose.

0.01, 1800000
0.03, 1100000
0.05, 500000
0.08, 250000
0.10, 130000
0.13, 79000
0.16, 52000
0.21, 28000
0.27, 19000
0.40, 10000
0.50, 6000
0.70, 4200
0.80, 3100
1.1, 1900
1.3, 1300
1.6, 1100
1.9, 1000
2.1, 900
2.4, 800
2.7, 750
3.2, 700
3.8, 650
4.3, 600
4.9, 570
5.4, 500
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